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Introduction
This document describes the setup for GA10 Data Logging Software.

■ Notice
•	 The	contents	of	this	manual	are	subject	to	change	without	notice	as	a	result	of	continuing	

improvements to the instrument’s performance and functions.
•	 Every	effort	has	been	made	to	ensure	accuracy	in	the	preparation	of	this	manual.	Should	

any errors or omissions come to your attention, however, please inform Yokogawa 
Electric’s	sales	office	or	sales	representative.

•	 Under	no	circumstances	may	the	contents	of	this	manual,	in	part	or	in	whole,	be	
transcribed or copied without our permission.

■ Trademarks
•	 Our	product	names	or	brand	names	mentioned	in	this	manual	are	the	trademarks	or	

registered trademarks of Yokogawa Electric Corporation (hereinafter referred to as 
YOKOGAWA).

•	 Ethernet	is	a	registered	trademark	of	XEROX	Corporation	in	the	United	States.
•	 We	do	not	use	the	TM	or	®	mark	to	indicate	these	trademarks	or	registered	trademarks	

in this user’s manual.
•	 All	other	product	names	mentioned	in	this	user’s	manual	are	trademarks	or	registered	

trademarks of their respective companies.

2014.01.14
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Let’s actually connect devices to GA10 and collect data.

* To connect the UT, PR, or JUXTA series; other Modbus devices; or the 
WT series, see Section 10.

1. Collecting Data with GA10 for the First Time

GX20 MW100

GA10

- 2 -

Download GA10 from the Web site, and install it in your PC.

2. Installing GA10

Right-click InstallE_x86.exe 
(InstallE_x64.exe for the 64 
bit edition), and click Run as 

administrator.

To use GA10 as a trial 
version, you do not need 

to enter a license key.

Follow the wizard 
instructions to install 

the application.
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Start GA10.

3. Simple Settings 1/4

Start from the Start menu.

User Name : admin
Password : (blank)
Click OK the first time.

- 4 -

Assign a name to the project.

3. Simple Settings 2/4

1. On the File menu, click New Project.

2. Enter a name, and click OK.

3. Double-click the new icon.
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Simply register devices, and you can start collecting data.

3. Simple Settings 3/4

5. Drag the detected GX20 
and MW100 to register.

4. Search for 
devices.

6. Start data collection 
and recording.

Monitor: Monitoring only
Record: Saves data to file.

• Select the device name.
• Enter the IP address or 

serial settings.

* If you cannot search, 
use the Register Device 
button.

* For details on using the UT, PR, 
or JUXTA series; Modbus devices; 
or the WT series, see section 10.

- 6 -

You can start collecting data by simply performing the 
aforementioned steps.

3. Simple Settings 4/4

Data collection starts.
Top: Trend monitor
Bottom: Digital monitor

A group is 
created for each 

device.
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If you recorded data, you can view the data with the viewer.

4. Viewing the Recorded Data

2. Double-click the data 
that you want to view.

1. Click the icon on the 
right side to switch to the 

data list page.

The viewer starts.

- 8 -

Switch to Detail Settings mode.

5. Changing the Settings in Detail (Detail Settings)

Click the Detail 
Settings button.

Use the tabs on 
the right side to 
switch pages.

Detail Settings 
mode

Set the items in the 
left menu in order 

from the top.
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You can change tag numbers and tag comments.

6. Changing Tag Names (Detail Settings)

You can enter tag 
numbers and tag 

comments.

You can copy and paste selected lines, turn 
on and off tags collectively, and assign 
numbers automatically (increment).z

Select Tag.

- 10 -

You can assign tags to different groups as you like.
You can change how to display the waveforms, such as the 
waveform color, meter type, Y-axis, and scale.

7. Assigning Tags to Groups and Changing the Display (1) 
(Detail Settings)

Group tags any way you like.
Automatic assignment by device or by 
a specific number of tags is possible.)

On the View menu, 
click Display Group.

Display group 
name Y-axis to use 

for trends
Meter display 

type

Max. and min. 
scale values to 

display
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7. Assigning Tags to Groups and Changing the Display (2) 
(Detail Settings)

Zone

Trip: Displays a horizontal guideline
Example: Specify 5.0.

Zone: Specify the vertical 
waveform position.
Example: Specify 1 to 25, 25 to 
75, and 75 to 100.

Trip

- 12 -

We recommend you use “PC time,” which does not divide the 
screen or files.
Use “Device time” to back up data or when replacing DAQ32Plus.

8. Selecting the Data Time

Timestamp
Collection 
and record 

interval
Backfill* Monitor page

(Trend/Alarm) Data file

PC time Time on the 
PC

Can be set 
freely

No Displayed on a 
single page

Saved to a 
single file

Device time Time on the 
device

Uses the 
interval on 
the device

Yes Page divided by 
device or 
collection 
interval

File divided by 
device or 
collection 
interval

* Backfill operates under the following conditions.
• Applicable devices: GX/GP/DX/MV
• Data is retained in the device’s internal memory.
• The device’s FTP function is on.

• Monitoring applications on a PC
• If you want data to be consolidated into a single file
• For replacing DAQLOGGER

• Data backup applications
• For replacing DAQ32Plus 
(using one Darwin unit)
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The monitor page can be divided into up to 16 monitor sets.

9. Changing the Monitor Page (Detail Settings)

Example 1: 4 monitor sets 
(horizontally divided into 2)

Example 2: 6 monitor sets 
(horizontally divided into 2)

The available display 
types are trend, digital, 
meter, and alarm.

Check the preview.

On the View menu, 
click Acquisition & 
Monitor.

- 14 -

To connect a UT, PR, or JUXTA series device or other Modbus 
device, you need to register a “definition file” containing the 
device information in GA10.

10. Connecting a Modbus Devices

Contains Modbus 
registers, coefficients, 
and other informationModbus device

GA10

Save to a 
specific folder.

Modbus 
definition file
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Download a sample file from the Web site, and edit it using 
Windows Notepad.

11. Creating a Modbus Definition File (1/2)

From the Start menu, select 
Accessories and then Notepad.

When you finish editing, 
be sure to use Save As to 

save the file. Set the 
character coding to UTF-8.

Drop the sample file on 
Notepad and edit.

(For editing instructions, 
see the next page.)

- 16 -

<?xml version="1.0" encoding="utf-8"?>
<ModbusDevice Type="UT55Asample">

<Registers>
<Register Name="PV1" FunctionCode="3" Address="42003" DataType="INT16"></Register>
<Register Name="SP1" FunctionCode="3" Address="42004" DataType="INT16"></Register>

</Registers>

<Channels>
<Channel Name=“PV1” DecimalPos=“1” ScaleRatio=“1” ScaleOffset=“0” Unit=“degC”>

<Value Register="PV1"> </Value>
</Channel>
<Channel Name=“SP1” DecimalPos=“1” ScaleRatio=“1” ScaleOffset=“0” Unit=“degC”>
<Value Register="SP1"> </Value>

</Channel>
</Channels>

</ModbusDevice>

Key points for editing the sample file

11. Creating a Modbus Definition File (2/2)

1. Device name that appears when 
registering the device to GA10

2. Channel name, function 
code, register, data type

3. Decimal place, 
scale, offset, unit

Channel name: PV1
Function code: 3
Register number: 42003
Data type: INT16
Decimal place: 1
Scale: 1
Offset: 0
Unit: degC

Channel name: SP1
Function code: 3
Register number: 42004
Data type: INT16
Decimal place: 1
Scale: 1
Offset: 0
Unit:degC

This sample is for loading PV1 and SP1 of a UT55A.

Add as 
necessary.
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Copy the file to the specific folder.

12. Copying the File Created in Step 1 to a Specific Folder

Copy the file 
you created.

Paste to C drive
>Program Files
>Yokogawa Electric Corporation
>SMARTDAC+ Data Logging Software
>Modbus

- 18 -

Restart the GA10 service.

13. Restarting the Server

Select DLGServer, click 
Stop and then Start.

On the Start menu, click 
Control Panel and 

Administrative Tools, and 
double-click Services.
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On the GA10 Setting Page, register the device that you defined.

14. Register the Device to GA10

The device is added 
to the list.

- 20 -

Download GateWT for GA10, and use it to make the connection.
License: You can install it using the GA10 license key.
Applicable models: WT210/230/500/1800

* The WT310/330 can be connected using the WT210/WT230 compatible command mode.

Communication port: Ethernet or serial

15. Connecting a WT Series Device

Select Gate on the 
GA10 Setting Page.

Connect the WT 
and run.

WT series

GA10

GateWT 
for GA10
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Be sure to read “Readme.txt”
Install GateWT for GA10.

16. Installing GateWT for GA10

Follow the wizard 
instructions to install 

the application.
Enter the GA10 license key.

Right-click Install.exe, and 
click Run as administrator.

- 22 -

Start GateWT for GA10.

17. Configuring GateWT for GA10 (1/2)

ETHER: Enter the address (IP address).
COM: Set on the serial setting tab in 
advance.

Switch tabs Switch tabs

4. On the Scan Interval 
Setting Tab, set the scan 

interval (msec).

3. Double-click the 
device number to set 
the channels to load.

1. Select the 
communication method.2. Select the device 

to automatically 
detect the device 

type.
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When you finish the settings, register the device to GA10.

17. Configuring GateWT for GA10 (2/2)

6. On the Execution/Status 
tab, click the process 

execution button.

7. Register the device on 
the GA10 Setting Page.

Device type: Gate
IP address: localhost

9. Check that the PC 
information is added to 
the connection status.

8. Start data collection 
and recording on GA10.

Switch tabs

- 24 -

Please replace DAQWORX with GA10.
However, in the following cases, use the existing software together 
with GA10.
– Windows XP or earlier is in use.
– Connecting to a discontinued product.
– GP-IB communication is in use.
– Event processor (e-mail transmission, FTP transfer, html 

conversion, etc.), report function, file utility (file split and 
merge), math channels, AO channels, or DO channels are in use.

– AddTrigger, AddObserver, or DataBrowser is in use.

18. To DAQWORX Users

Replace entirely Use with existing software
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Reconfigure the system using GA10.
To save the current settings, use the DAQWORX print function.

19. Replacing Entirely (1/2)

DAQLOGGER environment settings (ENVI) example

GA10

Replace entirely

GX20MW100DX1000

‘ENVI’

File>Print
The print function 
is available for 
certain settings.

Reconfigure.

- 26 -

You can reduce the burden of configuration by using the GA10 tag 
import feature, tag auto assignment feature, and the Action bar.

19. Replacing Entirely (2/2)

Detail Settings > Tag Detail Settings > Display > Display Group

Detail Settings > Tag or Display
You can copy and paste selected 

lines, turn on and off tags collectively, 
and assign numbers automatically 

(increment).

You can load a list of tag 
names and tag comments 

that you created with Excel, 
Notepad, etc.

You can use automatic 
assignment by device or 
by the number of tags.
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There are two methods.
(1) Mix GA10 with existing software

You can use the current configuration and add GA10.
(2) Connect GA10 as a host

By integrating GA10 as a host to DAQWORX, collected data 
can be consolidated in GA10.

20. Using Existing Software with GA10 (Two Methods)

μR1000

GA10

DX100

DAQ
LOGGER

(1) Mix GA10 with 
existing software

GX20

Add
Multi

(2) Connect GA10 
as a host

μR1000

GA10

DX100

DAQ
LOGGER

GX20

Add
Multi

Existing system Existing system

Use with existing software

Data can be 
consolidated in 

GA10.

No 
reconfiguration 

necessary.

- 28 -

Install GA10 in the PC that you are using, and configure it.

21. Using Existing Software with GA10 
((1) Mix GA10 with existing software)

μR1000

GA10

DX100

DAQ
LOGGER

Configuration 
example

GX20

Add
Multi

Install GA10.

Existing system
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Data that DAQWORX Data Logger is collecting will be consolidated 
in GA10.

22. Using Existing Software with GA10 
((2) Connect GA10 as a host)

Configuration 
example

μR1000

GA10

DX100

DAQ
LOGGER

GX20

2. On the Register 
Device page, select 

DAQLOGGER.

Click Manager M.SERV 
to start the monitor 
server.

1. While data 
collection is in 

progress, start the 
monitor server.

Device type: DAQLOGGER
Host name: Enter the PC IP 
address (or “Localhost”).

GA10 will automatically be 
assigned with the same tag 

name as DAQLOGGER.

Add
Multi

Existing system

- 30 -

23. Functional Comparison with DAQWORX

DAQLOGGER DAQ32Plus MXLOGGER GA10

Basic features

Connectable devices Many devices Darwin MX100 Many devices
Number of device 
connections 32 1 20 100

Number of measurement 
channels 1600ch 300ch 1200ch 2000ch

Number of math channels No 60ch 240ch (TBA)

Collection (scan) interval 1 s or more 0.5 s or more 10 ms or more 100 ms or more 
(10 ms or more)*

Logging
Trigger acquisition Option Option Option Yes
Collection in groups 
(multilogging) Option Option Option Yes

Data processing
(event processor)

Auto data conversion Yes Yes Yes Yes

e-mail transmission Yes Yes Yes
Yes

SMTP authentication 
support

FTP transfer Yes Yes Yes No
Simple report output Yes Yes No No

Monitoring function
Remote monitoring (client) Option Option Option Option

Graphic monitoring Option Option Option No
Device 

configuration/control
Device configuration Yes Yes Yes Standard software
IO/AO module control No Yes No No

Utility File merge, split, reconfigure Yes Yes Yes No

User privilege User privilege No No No Yes
Other DDE server Yes Yes Yes Yes
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